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はじめに 
Merging Technologies の公式 DSD & DXD ワークフロー ガイドへようこそ。このガイドでは、Pyramix 
Virtual Studio を使用して DSD および DXD コンテンツを 録音、編集、および マスター作成 までの方法
について説明します。 
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WHAT ARE DSD & DXD? 

DSD の概要 

ダイレクト ストリーム デジタル （DSD）は、標準的な PCM（パルス コード変調）サンプリング方法とはまった
く異なる方法で動作するアナログ信号をキャプチャ （サンプリング）する方法です。 

 
 

 
PCM デジタル オーディオの仕組みについて簡単に
おさらいしましょう。 

これは、アナログ オーディオ信号をデジタルでキャプチャし
て表現する方法です。波形の振幅は、1 秒間に何千回もス
ライスでキャプチャされます。 

1 秒間にキャプチャされる回数は、サンプル レート （Hz で
測定）に基づきます。たとえば、48 kHz のサンプル レートで
は、振幅測定が 1 秒間に 48,000 回行われます。 

これらの測定にはそれぞれ、測定を行う際の解像度があり
ます。これは基本的に、測定を行う際の精度です （ビット単位で測定)。16 ビットの測定では、65535 の振
幅位置の可能性があります。また、24 ビットの測定では、16,777,216 の振幅位置の可能性があります。こ
れは大きな増加ですが、アナログ オーディオ信号で基本的に無限にある可能性のある振幅位置の数より
ははるかに少ないです。 

したがって、どのようにカットしても、高周波数では、キャプチャしようとしていたものの「真の」表現ではなく、
元のサウンドの近似値が得られます。この事実をますます最小限に抑えるのに役立つのは、より高いサン
プル レートです。 

ナイキストとローパス フィルター 

PCM オーディオのもう 1 つの「問題」は、サンプリングを行う前にローパス フィルターを実装する必要があ
ることです。これは「ナイキスト」効果によるものです。オーディオをデジタルでサンプリングする場合、より高
い周波数のオーディオをキャプチャしようとすると、ある時点以降、デジタル コピーに聞こえる歪みが生じま
す。これは、周波数がサンプル レートの半分を超える信号をサンプリングすると、信号が誤って表現される
ために発生します （画像を参照）。 

PCM を使用するには、サンプル モジュールに高
周波数が届かないようにブリック ウォール フィル
ターを配置する必要があります。そうしないと、可
聴スペクトルに歪んだノイズが発生します。 

44.1 kHz （Red Book、オーディオ CD サンプル 
レート標準）の半分は 22.05 kHz で、これは平均
的人間の可聴範囲をはるかに超えています。しか
し、これらの超音波周波数と倍音は、人間の体が
「感じる」ものであり、それらが存在すると、サウンド
をより楽しく「リアル」にすることができます。 
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周波数応答：キャプチャしているものを別の方法で見る 

音の中で聞こえるのは調性だけではありません。超高速で超短いノイズも「過渡的」として聞こえます。これ
らは、たとえばピアノの鍵盤を叩いたときとギターの弦を弾いたときの違いを判断するのに役立つクリック音
とポップ音です。フレットのノイズや、弦を弾くときに爪でカチッと鳴らす音は、アナログの世界では簡単に聞
き取ることができますが、周波数が非常に高いため、低いデジタル サンプリング レートで捉えるのは非常
に困難です。 

 
 

 

 
 

dsp  Japan  Ltd, 4-8-5 Nakameguro, Meguro-ku, Tokyo 153-0061 
T ：03-5723-8181 F ：03-3794-5283 U ：http://www.dspj.co.jp 

3 



 
 

 
 

DSD ではどうでしょう ? 
DSD は、上記の方法とはまったく異なります。1 秒間に数千回、ビット数ごとの詳細な振幅測定を行うので
はなく、1 ビット（アップの場合は 1、ダウンの場合は 0）の前回の測定からの信号振幅の変化を 1 秒間に
数百万回記録するだけです。 
負のフィードバック ループを使用して、1 と 0 の密度を調べることで、このバイナリ データから信号を推定
することができます。 

 
上の画像では、信号がどのようにキャプチャされるかを簡単に視覚化できます。 

アナログオーディオストリームをデジタルでキャプチャするこの方法は、周波数応答が大幅に改善されるだ
けでなく、DSD を真のアナログ相当にする他の多くの要素も得られることを意味します。 

 

DSD64、DSD128、DSD256：選択肢は他にもありますか? 

Pyramix には 3 種類の DSD があります。それぞれの後ろの数字は「FS」で、「サンプリング周波数 （下付
き文字)」を表します。1 FS は 44.1/48 kHz のサンプリング周波数を表します。2 FS は 88.2 / 96 kHz、4 
FS は 176.4 / 192 kHz です。つまり、DSD 64 は CD のサンプリング周波数の 64 倍で、2.4 MHz に相
当します。つまり、DSD256 は 11.2 MHz、つまり 1 秒あたり 11,200,000 サンプルです。 

DSD64 （CD サンプリング周波数の 64 倍）= 2.8224 MHz 
DSD128 （CD サンプリング周波数の 128 倍）= 5.6448 MHz 
DSD256 （CD サンプリング周波数の 256 倍）= 11.2896 MHz 

ここでの選択は、さまざまな PCM 形式を選択する場合と同じです。ドライブの空き容量、処理能力、および
クリエイティブな意図によって、より大きな DSD 形式を使用するか、より小さな DSD 形式を使用するかが
決定されます。 
 

ノイズ シェーピングと DSD の超高周波ノ
イズ 

アナログに戻された DSD 信号を見ると、超高
周波範囲でレベルが大きく上昇していることが
わかります。DSD 信号のノイズ スペクトルは 
22kHz を超えると増加します。これは、プライマ
リ オーディオ バンド （20Hz ～ 20kHz）の 
120dB のダイナミック レンジを得るためにノイ
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ズ シェーピング プロセスが使用されるためです。 

これは単にサンプリング時に信号に追加されるディザのようなノイズであり、元のオーディオ ストリームの同
じ超高周波を処理するときに追加の量子化エラーを防ぐためなので、心配する必要はありません。DSD「タ
イプ」を選択するときに注意すべきことの 1 つは、DSD レートが高いほど、このノイズが周波数スケールの
さらに上、つまり DSD128 の場合は 44kHz を超えることです。 

 

WHAT IS DXD ? 

DXD （Digital eXtreme Definition）は、Merging Technologies が開発した PCM サンプルレートです。
DXD は 352.8 kHz/24 ビットのオーディオ信号で、DSD 信号を PCM（オーディオをデジタル化する標準的
な方法）の世界にシームレスに移行して、EQ、ダイナミクス、その他のエフェクト処理を実行できるようにす
るために使用されます。DSD256、DXD、および地球上で最も透過的な SRC でサンプルレート変換を自動
的に実行できるタイムラインの組み合わせにより、Pyramix は音響的に最も印象的なワークステーションと
なっています。 

 

DSD の問題は何でしょうか? 

DSD は 1 と 0 として存在します。前のセクションで説明したすべての理由から、これは信号の録音と再生
に最適です。しかし、その信号に何かを「実行」しようとするとすぐに大きな問題が発生します。基本的に、こ
れは  DSD が純粋なデジタル領域で「ミックス不可能」であることを意味します。 

たとえば、そのファイルのゲインを変更したいとします。ゲインを変更するには、各サンプルのパーセンテー
ジを計算して新しいゲイン「レベル」に到達する必要があります。1 と 0 しかない場合は、これは不可能で
す。しかし、この制限には DXD という解決策があります。 
 
Pyramix は、DSD 形式と DXD 形式をオンザフライで変換できます。 

●​ DSD ファイルにフェードまたはクロスフェードを作成すると、Pyramix はフェードされたセクションをリア
ルタイムで DXD に変換して編集を計算し、出力段階で DSD に再変調します。 

●​ 出力先形式が MTFF の場合、処理対象の領域の DXD バージョンを作成するだけなので、Pyramix 
のレンダリング ツール （Cedar や Algorithmix ReNOVAtor など）を DSD ファイルで使用できます。 

●​ DSD プロジェクトを「DXD ミキシング モード」で開くと、ミキサーと 192 kHz を超えるサンプル レートで
動作するプラグインに完全にアクセスできます。DXD 対応の VST はごくわずかです。DXD 対応プラ
グインのリストを参照してください。 

つまり、DXD は、このような高いサンプリング レートで高度な編集機能とデジタル ミキシング機能を使用す
るための Merging社のソリューションです。 
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DXD は DSD 作業にのみ使用されますか? 

いいえ、そうではありません。DXD は、多くの分野での制作やマスタリングに使用される、非常に人気の高
いサンプル レート形式です。たとえば、いくつかのクラシック音楽レーベルでは、SACD と純粋な DXD デ
ジタル バージョンの両方をリリースしています。DXD は、目的やワークフローに応じて、制作プロセスで優
先される形式になることもあります。このトピックについては、次のセクションで説明します。 
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MAKING THE CHOICE：DSD, DXD OR DSD IN DXD  

CHOICES OF WORKFLOW AND WHAT IT WILL MEAN 
 

WORKING IN DSD 
●​ ファイルは A/D から直接 DSD 信号として記録されます 

●​ プロジェクトのミキサーは固定されており、信号に影響を与えたり、トラックをまとめて出力バスに出力し
たりすることはできません。 

●​ タイムラインの一部を編集できます。編集した内容はすべて DXD に変換され、編集処理後に DSD に
再変換されます。編集されていない部分だけが純粋な DSD になります 

●​ タイムライン上のファイルの位置に基づいてのみ最終マスターを作成できます 
○​ トラック 1 と 2 が埋められている場合はステレオ マスターが作成されます 
○​ トラック 1 ～ 6 が埋められている場合は 5.1 マスターが作成されます 

■​ 最終マスターの作成にサミング バスは使用できません 

なぜこのように作業するのか: 

●​ DSD 純粋主義者であり、録音をできるだけ「そのまま」にしておきたい。 

●​ アナログ マスターをキャプチャしており、「デジタル化」以外は何もしたくない。 

●​ マイク配置の専門家であり、マイクを「あるべき」場所に正確に配置することで録音に命を吹き込むこと
ができるため、録音したものをミックスしたり、影響を与えたりする必要がありません。 

●​ アナログ機器を使用してミックスしており、DSD プレーヤー/レコーダーが必要です。 
 

WORKING IN DXD 
●​ ファイルは A/D から DXD 信号として直接記録されます 
●​ PCM の世界に DXD が存在するため、ミキサーとすべての編集ツールに完全にアクセスできます。 
●​ すべての編集とレンダリングは DXD サンプル レートで行われます。 
●​ サミング バスを使用して最終的なマスターを作成できます。 
●​ これらのマスターは DXD および DSD レート ファイルです。DSD レート ファイルの場合、ミキサー出

力で DXD から DSD への変換が行われます。 

この方法で作業する理由： 
●​ サウンドをキャプチャした後、サウンドに多くの作業を行うことがわかっている場合 （編集、イコライザー

など)。 
●​ 制作中にボックス内でミキシングするか、Pyramix ミキサーを使用する場合：アーティストへのキュー送

りなど 
●​ SACD 仕上げが必要な場合は、マスタリング段階で DXD から DSD に変換します。 

 

DXD プロジェクトで DSD を使用する 
●​ ファイルは A/D から直接 DSD 信号として記録されます 
●​ PCM の世界に DXD が存在するため、ミキサーとすべての編集ツールに完全にアクセスできます。 
●​ 触れるものすべてが DXD に変換される方法を使用して、タイムラインの一部を編集できます。編集せ

ずに残っ​​た部分だけが純粋な DSD になります。 
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●​ サミング バスを使用して最終マスターを作成できます 
●​ これらのマスターは DSD レート ファイルになります 

○​ ミキサー出力で DXD から DSD への変換が行われます。 

なぜこのように作業するのか: 
●​ 録音したファイルの形式にこだわり、DSD にしたい 
●​ プロデューサーにミックスを提供し、アーティストにキューを送るために録音プロセスに DXD ミキサー

を使用しているが、最終的なマスターには高度なミキシング機能が必要ないため、編集時に DSD モー
ドに切り替えたい。 

 
DSD64 / 128 / 256 AND WHY TO CHOOSE ONE OR THE OTHER 

ここで、どの選択をするかに影響する決定が 1 つあります。ミキシングのために DXD にパスせずに 
SACD を作成しますか? 

答えが yes の場合、タイムライン上のメディアが DSDIFF DSD64 であることを確認する必要があります。
それ以外の場合は、レンダリング モードの SACD を作成することはできません。 
ただし、最終段階で DSD CONVERTER アプリを使用して、DSD128 または 256 から DSD64 にダウン
サンプリングすることもできます。 

その選択を行った後、使用されるディスク領域、提案された成果物のサンプル レートなどの通常のパラメー
ターに基づいて、残された選択肢を検討できます。 

したがって、上記について決定を下す際に尋ねるべき質問は次のとおりです。 

●​ 最終的にどのような製品にするつもりですか? 
○​ SACD 
○​ DSD または DXD デジタル ダウンロード 
○​ 「標準」ファイル （CD、MP3/AAC など) 
○​ 上記すべて 

●​ 可能な限り、コピーのコピーは避けるべきなので、DSD->DXD->DSD 変換を最小限に抑えるにはどう
すればよいですか。DSD ファイルが Pyramix で処理されるたびに再変調が発生し、これにより追加の
超音波ノイズが生成されます。 

●​ ボックス内でミックスする必要がありますか? 

●​ 録音を特定の形式で保存する必要がありますか? 
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メータリングと許容レベル 
SACD および DSD 制作には、周波数範囲のさまざまな帯域で非常に具体的な計測とレベルの要件があ
ります。SACD 製造工場では、正しく適合しないマスターを拒否するため、不要な追加作業を避けるために
計測を適切に設定する必要があります。 

これらの計測スケールは、最終的に DSD メディアになるすべての制作で遵守する必要があります。つま
り、SACD ディスクとデジタル ダウンロード用の DSD ファイルの両方が含まれます。これらのガイドライン
に従う必要がないのは、DXD で作業し、DXD マスターで仕上げる場合のみです。 
 
まず、dBSACDについて知っておく必要があります。dBSACDスケールはdBFS（フルスケール、または可
能な最大デジタルレベル）に関連していますが、SACDの実際の最大レベルに達する前に「安全ゾーン」を
可能にする別の0レベルがあります。以下の表を参照して、探しているものに慣れてください。 

 dB SACD dBFS (Dull Scale) 

リファレンス レベル 0 -6 

最大レベル +3.1 -2.9 

 
 

DSD を扱う場合の Pyramix ミキサー メータリング 
**重要な注意**  
DSD プロジェクトで作業している場合、Pyramix ミキサーは dBSACD 表示に変わります。ユーザーが更
新または変更する必要はなく、プロジェクトの DXD バージョンと DSD バージョンを切り替えると、メータリン
グはそれに応じて調整されます。 

 
20HZ -20 KHZ 範囲 （SACD SCARLET BOOK の付録 D3） 

可聴範囲では、SACD 仕様では作業の最大レベルは 0dBSACD であると規定されています。これを基準
点として、SACD は「一時的に」+3.1dBSACD までピークに達することも許可されています。 

しかし現実には、このような +3.1 dBSACD を使用すると、ピークが発生する （またはピークが著しく制限さ
れる）可能性があるため、SACD 製造施設で拒否される可能性があります。SACD レベルに関する 2 つ目
の警告は、Pyramix ミキサーの計測 （ピーク メーター）は、最も正確な計測器では​​ないということです。特に 
DSD プロジェクトで計測する場合、最大 +/- 1 dB の誤差が生じる可能性があります。Pyramix 環境にお
ける最大 DSD 信号は、+1 dB-SACD を超えないようにしてください。 

 
40 KHZ -100 KHZ の範囲 （SACD SCARLET BOOK ANNEX D4） 

DSD 作業では高周波をすべて除去するブリック ウォール フィルターは使用されていないため、SACD 仕
様ではこの範囲も考慮する必要があります。SACD 仕様では、この周波数範囲は -20dBSACD を超えて
はならないと規定されています。 
高周波ノイズを任意の時点で確認するには、All Settings > Mixer Settings > Level Meter で、DSD 
フィルターを 40 -100kHz に変更できます。 

***注意*** DXD プロジェクトでは、出力バスに VU VS3 プラグインをロードして、40 ～ 100kHzの帯域を
表示するように設定できます。これにより、チャンネル メーターは 0 ～ 20kHz 帯域を自由にモニターできま
す。 
VU メーターを開き、UI 内で右クリックします。DSD タブで、40k - 100kの帯域を選択します。 
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DC オフセット （SACD SCARLET BOOK ANNEX E） 

SACD 制作では DC オフセット レベルも重要です。SA​​CD 仕様では、DC オフセット レベルは 
-50dBSACD を超えてはならないと規定されています。これは最近、最新の Scarlet Book 仕様から削除
されましたが、参考として記載します。また、ワークフローに関係なく、オーディオに DC オフセットがないよ
うにすることも、一般的な良い方法です。 

TIP：録音メーターを設定し、DC オフセットがないことを確認する 
 

Pyramix システムでは、PCM であれ DSD であれ、すべての録音で実行する必要があります。マスターに 
DC オフセットが存在すると、ヘッドルームが減少するだけでなく、リスナーのスピーカーなどに悪影響を与
える可能性があります。Pyramix には DC オフセット メーターがありますが、すべてのプラグインと同様に、
DSD では機能しません。 

したがって、最初に DXD プロジェクト（デフォルトのプロジェクトでかまいません）を作成し、すべての入力ス
トリップに VS3 DC オフセット メーター プラグインをロードして、DC が存在するかどうかを測定することを
お勧めします。開始前にこれを行う理由は、録音後、存在する DC オフセットを削除する唯一の方法は、
DXD に変換してから DSD に再変調することであるためです。ほとんどの DSD 愛好家がやりたいことで
はありません。 

 
MERGING IO インターフェイス ユーザーへ 
DSD 作品を録音するために、Merging のネットワーク オーディオ インターフェイスのいずれかを使用して
いる場合は、上記の DC チェックについて心配する必要はありません。これは、Merging社が生産するコン
バーターのすべての入力に DC 除去ユニットがハードワイヤードで組み込まれているためです。 
 

CHOOSING YOUR DSD COMPUTER 
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Pyramix ソフトウェアと DSD/DXD アートへのその応用について話す前に、まず、一部の人には当たり前
のことのように思えるかもしれないが、ここでは率直に述べる価値があるコメントから始めなければなりませ
ん。 

DSD/DXD で問題なく操作を行うには、非常に優れた強力なワークステーションが必要です。 

ここで、Merging Technologies がラックマウント型と完全に静かなデスクトップ型の両方で、DSD および 
DXD 対応のターンキー コンピュータ システムを特別に設計および構築していることもお伝えします。ラップ
トップを DSD 作業にも使用しようとした場合に起こるサポートの問題を何度も経験しています。 

DSD または DXD システムをセットアップする際には、ファイルのサイズ、必要なハード ドライブ速度、リア
ルタイム処理能力など、さまざまな要素が重要です。したがって、Merging 製の PC を使用しない場合は、
PC 構成ページを確認して、作業に適した独自の PC を製作または購入してください。 
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DSD / DXD での MASSCORE と NATIVE の違い 
最近のコンピューターは非常に高性能なので、ネイティブ プラットフォームでも DSD や DXD の作業はあ
る程度可能ですが、MassCore システムほどではありません。 

パフォーマンスの違いを簡単に説明します。 
 

NATIVE  MASSCORE 

Max Track Count  Max Track Count 

DXD 8ch 
Merging I/O と Merging ASIO 
Driver を使うと16ch 

 DXD 64ch 
Merging I/O が必須 

DSD 64/128/256 8ch 
Merging I/O と Merging ASIO 
Driver を使うと16ch 

 DSD 64/128/256 64ch 
Merging I/O が必須 

Latencies  Latencies 

Minimum Latency 48 Samples (MT-ASIO v11)  Minimum Latency 32 Samples 

VS3 Plugin Latency 加算される  VS3 Plugin 
Latency 

含まれる 

録音時の制限 DXDプロジェクトで DSD を録
音することはできません 

 録音時の制限 無し 

ミックス時の制限 無し  ミックス時の制限 無し 

 
さまざまなソフトウェア パックの詳細については、Mrerging 社の Web サイト をご覧ください。 

DSD または DXD の単一のサラウンド レイヤーのみを録音および編集し、ヘッドフォン フィードなどを提供
する必要がない場合は、Native で十分です。より多くのトラック数と、プラグイン使用時でもレイテンシーが
低い録音、編集、ミキシング が必要な場合は、MassCore が最適です。 
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PYRAMIX CONFIGURATION 
Pyramix をインストールしたら、DXD/DSD で使用するために設定することがいくつかあります。Pyramix 
は、さまざまなアプリケーションに最適なツールに「適合」するように設計されているため、Pyramix で何をし
たいのかを伝えるのに 1 ～ 2 秒余分にかかることになります。 

AUDIO ENGINE CONFIGURATION 
 

VS3 CONTROL PANEL 

Pyramix は、メインの Pyramix アプリケーションとは別に小さなアプリケーションを使用してオーディオ エン
ジンを設定します。VS3 Control Panel は Windows コントロール パネルからアクセスできます。 
 

NATIVE SYSTEM の DSD/DXD 設定 

MassCore エンジンを使用せずに Pyramix を使用する場合は、
Native モードで実行されます。つまり、Pyramix はホスト PC の 
CPU を、その時点で実行されている他のアプリケーション（
Microsoft Word など）と共有することになります。Native モードで実
行するには、PC の専用サウンド カード出力を使用して実行するか、
コンピューターへの接続に ASIOオーディオ インターフェイスが接続
できるように Pyramix を設定する必要があります。オーディオ イン
ターフェイスの箱または取扱説明書のどこかに Windows ロゴが表
示されていれば、互換性があるはずです。現在入手可能なインター
フェイスの約 99% は互換性があります。 
ただし、DSD および DXD のサンプル レートに対応しているのは、
これらオーディオ インターフェイスのごく一部だけです。 
また、Pyramix Native は録音時に DSD を DXD に変換できないた
め、DSD を録音するには DSD プロジェクトを実行する必要がある
ことにも注意してください。 

インターフェイスが DXD および/または DSD に対応しており、
Pyramix で使用できることを確認してください。  

100% 確実にするためには、インターフェイスの製造元に問い合わ
せて確認することをお勧めします。 

 
ASIO オーディオ インターフェイスへの接続 （ASIO インターフェイスは、正常に動作するために DSD また
は DXD に対応している必要があります） 
➔​ 現在承認およびテスト済みの DSD DAC のリストが必要な場合は、お近くの Merging Tech-nologies 

オフィスに問い合わせてください。もちろん、Hapi または Horus（Merging社の主力製品である DSD 
および DXD 対応のネットワーク オーディオ コンバーター）をお勧めします。 

➔​ デバイスのドライバー インストーラーをダウンロードまたは読み込みます。 
➔​ インストールします。 

 
NATIVE システム用の VS3 CONTROL PANEL の設定 
1.​ application のドロップダウンで「Pyramix」が選択されていることを確認します。 
2.​ Platform に「Native- ASIO」を選択し、使っているインターフェイス用のASIO ドライバーを選択しま

す。 
3.​ ASIODevice Bridge Mode を選択します: 
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4.​ Disable に設定します。これは DSD および DXD 作業には使用できません。 
5.​ applyをクリックして、VS3 CONTROL PANEL を閉じます。 
 

MASSCORE SYSTEM の DSD/DXD 設定 

ネイティブ システムでの選択とは少し異なりますが、MassCore エンジンを使用するには、まず MassCore 
エンジンをシステムにインストールする必要があります。詳細については、Pyramix installation guide for 
further details を参照してください （Merging社の Web サイトでも入手可能）。 

 
VS3 CONTROL PANEL を開き、次の操作を行います。 

1.​ 最初に “application” ドロップダウンで ”Pyramix” が選
択されていることを確認します。 

2.​ “Platform” に “MassCore” を選択します。 
3.​ “ASIO Device Bridge Mode” を選択し、無効に設定し

ます。これは DSD および DXD 作業に使用できる機能
ではありません。 

4.​ Merging RAVENNA ネットワーク インターフェイス カー
ド （NET-MSC-GBEX1）を On Bus に選択します。 

5.​ Apply をクリックして、VS3 Control Panel を閉じます。 
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最初の PROJECT を開始する 
すべての考慮事項を検討し、超高サンプル レートでどのように作業するかを決定したら、このセクションで
は、前述した 3 つの操作モードのいずれかを設定する方法について説明します。 

次からの章についての注意 
DXD は PCM 形式であるため、作業時に特別な考慮事項はありません。そのため、高解像度でのセット
アップ、録音、編集、ミキシング/マスタリングの概念に関する章では、特別な考慮事項が必要となる DSD 
での作業についてのみ説明します。DSD ファイルではなく DXD のみを作成する必要があるときは、ワーク
フローは他の PCM サンプリング レートの場合と同じです。 

純粋な DSD プロジェクトの設定 

DSD プロジェクトの操作方法は制限されています。これは、DSD が「ミックスできない」ためであり、このセ
クションで DSD プロジェクトを作成すると、その中のトラック数を変更することはできません。 
したがって、後でトラックを追加する必要がある場合は、新しいプロジェクトを作成し、最初のプロジェクトか
らメディアをコピーして 2 番目のプロジェクトに貼り付ける必要があります。 
編集をすでに行なった場合は、Library を使用して、トラック数が多いプロジェクトにファイルを転送してくだ
さい。新しい Global Library を作成し、タイムラインで必要なクリップを選択し（すべてのクリップを選択す
るには CTRL+A）、ALT+SHIFT を押したままライブラリで選択内容を Library にドラッグしてドロップしま
す。その Library をより大きなプロジェクトで開き、Library からタイムラインにドラッグしてドロップします。 

PROJECT > NEW 

ステップ 1：プロジェクト タイプの選択 
DSD を選択し、作業する DSD タイプを選択します。レンダリング モードを使用して SACD を作成する場
合は、DSD64 /2.8 MHz を選択する必要があります。 

ステップ 2：新しいプロジェクト ワークスペースの設定 
「Setup a new Project Workspace」とい
うラベルの付いたボックスをチェックすると、
新しいプロジェクトに名前を付け、プロジェク
トとメディア ファイルを格納する場所を選択
できます。プロジェクトの名前を入力し、有効
なパスを入力するか、Browse ボタンを使
用して適切なフォルダーを参照してください。
入力したら、Next ボタンをクリックして次の
手順に進みます。 

ステップ 3：ミキサーの選択 
新しいプロジェクトには、適切なミキサーが
必要です。ミキサーは、タイムライン トラック
のタイプ （mono/stereo etc.）と数、および 
サミング バス を設定するために使用しま
す。ただし、純粋な DSD プロジェクトの場
合、DSD はいかなる方法でもミックスできな
いため、この設定は簡単です。つまり、DSD ミキサーは、モノラル ストリップをモノラル バス出力に変換す
るだけです。 

➔​ Default Mixer：DSD プロジェクトには適用されません。これを選択しないでください。 
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➔​ Mixer Wizard：これを選択して、現在のウィザードを終了すると、新しいウィザードが開き、録音する 
DSD トラックの数を選択できます。 

➔​ Use Preset：純粋な DSD ワークフローには関係がないため、グレー表示されています。 

それでは、Mixer Wizard を選択して、トラック数を設定しましょう。 

Mixer Wizard 

Mixer Wizard を選択すると、新しい ウィザードが開きます。 

作業する DSD トラックの数を入力して、Next をクリックし
ます 

I/O Routing Page では、物理 I/O をミキサーの入力スト
リップと出力バスに論理的に接続しようと自動的に試みま
す。 

トレーニングのため、および基本的なミキサー構成の練習
をするときは、常にこのボタンがオフになっていることを確認
してください。次のセクションでは、物理 I/O をミキサーに手
動で接続する方法について説明します。 

 

 

DXDプロジェクトでPURE DXDとDSD
を使用するための設定 

DXD プロジェクトは「通常の」PCM 環境のように動作するため （バックグラウンドで DSD を録音している
場合でも）、このセクションではさまざまなタイプのミキサー ストリップとバスをここで作成できるため、より多
くの選択肢が提供されます。 

ステップ 1：プロジェクト タイプの選択 
DXD Mixing Project を選択し、next をクリックしま
す。 

ステップ 2：新しいプロジェクト ワークスペースの
設定 
Setup a new Project Workspace にチェックを入
れ、新しいプロジェクトの名前を付け、プロジェクトとメ
ディア ファイルの場所を選択できます。 
プロジェクトの名前を入力し、有効なパスを入力するか、
Browse ボタンをクリックして適切なフォルダーを参照し
ます。 
情報を入力したら、Next ボタンをクリックして次の手順
に進みます。 

ステップ 3：ミキサーの選択 
新しいプロジェクトには、適切なミキサーが必要です。ミキサーは、タイムライン トラックのタイプ （
mono/stereo etc.）と数、および サミング バス を設定します。繰り返しになりますが、DXD （DSD を録音し
ている場合でも）は標準の PCM プロジェクトのように動作します。そのため、自由にバスやストリップを追
加できます。 
➔​ Default Mixer：デフォルトとして設定されているタイムラインとミキサーを追加します。 
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➔​ Mixer Wizard：現在のウィザードで Finish をクリックすると、新しいウィザードが開きます。 
➔​ Use Preset：表示されるリストからミキサーを選択できます。 
Mixer Wizard をクリックすると、次のステップに進むことができます。 

MIXER WIZARD 

Mixer Wizard を選択すると、ウィザードが開きます。最
初のページの後に、このページが表示されます。 

Masters Configuration Page では、プロジェクトのバ
スの数と種類を選択します。各種類をいくつでも作成でき
ます。以下は、各種類の概要と、その種類を使用する理
由についての説明です。SA​​CD 制作にマルチチャンネル 
バスを使用する場合は、最終段階でチャンネル マッピン
グの問題を回避するために、5.0 または 5.1 SMPTE を
使用する必要があります。 
 
 
 
 
“TYPE” 選択についての説明 
BUS VS GROUP： 
➔​ Bus は、出力を物理出力 （I/O）に送るマスターです 
➔​ Group は、物理出力ではなく他のマスターにルーティングできるマスターです 

AUX VS MIX 
➔​ Aux は、各ストリップにゲイン調整機能があり、信号をミックスするために使用します。このタイプは通

常、外部機器やプラグイン FX への送り や 演奏者への送り などに使用されます。 
➔​ Bus は、オン/オフ パラメーターのみを持つマスターです。これは、ステム ミキシング や、ミックス全体

をモニターするための メイン ミックス バスを作成するときに使用されます。各再生ストリップのフル レ
ベルがステムに送られていることを確認する必要があるためです （すべてのダイアログ トラックをダイ
アログ ステムで提供する必要がある場合）。または最終ミックス。 

バスとグループの使用例 
Group（Aux / Mix）の使用例は次の通りです： 
➔​ Aux Group は、Aux Group マスターにインサートされたリバーブ プラグインに信号を送信する場合

に使用されます 
➔​ Aux Bus は、ナレーション アクターへのヘッドフォン送りを作成するときに使用されます。これは、ヘッ

ドフォンに接続された出力に直接送られるためです 
➔​ Mix Group は、ステム ミキシング時にステム自体を作成するために使用されます。これらのステム

は、最終的なミックスダウンが行われる最終的なミックス バスに直接送られます 
➔​ Mix Bus は、プロジェクトの最終的なミックスを作成する出力として使用されます。これは物理出力に

接続できるため、レイバック用のテープ マシンに直接ルーティングしたり、メータリングなどにルーティン
グしたりできます。 

 
Next をクリック 

Channels Configuration Page は、プロジェクトのチャンネル スト
リップの数とタイプを選択します。 
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Pyramix ミキサーはモノラルから 32.2 までのあらゆるストリップ タイプを受け入れることができるため、必
要なストリップの数とタイプを選択するだけです。 

***注意*** ここでの設定がミキサーでどのように表示されるかについては、リストが上から下へ、左から右
への順に入力されます。ミキサー ストリップ #1 は、最上行で作成される最初のストリップになります。 
 
Next をクリック 
 
I/O Routing Page は、物理 I/O をミキサーの入力ストリッ
プと出力バスに論理的に接続しようとします。 
トレーニング目的の場合、およびミキサー設定の基本的なこ
とを練習する場合は、このボタンをオフにしてください。次の
セクションでは、物理 I/O をミキサーに手動で接続する方法
について説明します。 
 
Finish をクリック 
 

 

DXDプロジェクトでDSD録音を行うために必要な追加設定 

プロジェクトを開始したら、次のパラメータが正しく設定されていることを確認してください。正しく設定されて
いないと、プロジェクトを開始できません。 

 
インターフェース I/O の DSD 設定 
➔​ インターフェースが DSD モードに設定され、DSD タイプ （DSD 64/128/256）がt正しく選択されている

ことを確認します。 
 

PYRAMIX の RECORD の設定 
➔​ Record File type のタイプ ドロップダウンで DSD ファイル タイプ （DSDIFF、DSF、WSD、MTFF）

が選択されていることを確認します。 
 

PLAYBACK/RECORD の設定 
➔​ All Settings > Playback/Record で、real-time SRC が Very High（Hepta – Apodizing）に設定

されていることを確認します。この変更を適用するには、アプリケーションを再起動する必要がありま
す。 

 
MIXER の DITHER の設定 
➔​ Pyramix DSD を使用するときは、Pyramix ミキサーの Dither機能は常にOffにしておいてください。

Redbook CD イメージ ファイルへの変換時に必要なディザリング/ノイズ シェーピングは、Generate 
CD Image / SACD Edited Master ウィンドウで設定できます。 
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RECORDING DSD 
録音ワークフロー内の設定について話す前に、2 つの異なる意見があると考えられるものについて再び議
論しましょう。 
最終納品の形式が何であるか、そしてその目標を達成する方法がわかっているときに音をどのようなファイ
ルで録音するかという問題は、非常に重要です。 

考えるべき最も重要なことは、このプロジェクトの作業中に PC内でミキシングを行うか どうかです。 
答えが「はい」の場合、Merging ではマルチトラックを DXD で録音することを検討することをお勧めします。
理由は単純で、素材を DSD で録音した場合、ミキシングを行うために DXD への変換段階を経る必要が
あり、最後に DSD に戻すために再度変換する必要があるためです。したがって、DXD でキャプチャする
と、変換段階を省くことができます。 
再変調ステップの数を最小限に抑えることが非常に重要です。DSD ファイルが Pyramix で処理されるた
びに再変調が発生し、これにより追加の超音波ノイズが生成されます。DSD ファイルに複数のプロセスを
適用することがわかっている場合は、これらのファイルを DXD で保存することをお勧めします。 

次のセクションは、DSD および純粋な DSD をマルチトラック ソースとして使用して作業を継続したい人向
けです。 

このようなワークフローは次のとおりです。 

➔​ 大型アナログ コンソールでミキシングしながら、Pyramix をマルチトラック レコーダー/エディターとして
使用する 

➔​ 古いアナログ マスターをキャプチャして DSD リリースとして再発行する 
➔​ ライブ コンサートの DSD リリース用にアナログ コンソールの出力をキャプチャする 
➔​ このラインに沿ったその他のワークフロー 
 

RECORD SETTINGS 

ここで考慮すべき最も重要なことは、最終的に何を出力するかと
いうことです。レンダリング モードで SACD を作成する場合、
DSD プロジェクトでは DSDIFF、DSF、または MTFF が使用で
きますが、DXD プロジェクトでは DSDIFF のみが使用できま
す。 

 
DSD ファイル タイプ 
Pyramix には、DSD 素材を処理でき、目的に応じて録音形式と
して使用すると便利なさまざまなファイル タイプがあります。これ
らの形式の詳細と、選択する理由については、以下をお読みくだ
さい。 

DSDIFF 
Phillips が開発した Direct Stream Digital Interchange File 
Format は、DSD を扱う際に選択できる 3 つの選択肢の中で
「プロフェッショナル」な形式です。DSDIFF には制作作業に必要
なあらゆる種類の情報を含めることができますが、DSF は「コン
シューマー」ファイル タグ付けが可能な形式です。また、MIX ではなく RENDERING する SACD 制作を
行う場合は、録音形式として使用することが絶対条件です。 
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SDM SETTINGS 
DSDIFF で録音することを選択した場合は、使用するシグマ デルタ モジュレーション （SDM）のタイプを選
択できます 

SDM B 
最も古い SDM タイプです。CPU リソースの点でも最も要求が少ないタイプです。録音中にPCのストール
が発生する場合は、これを試してみるとよいでしょう。ただし、他の 2 つのタイプほど優れておらず、SDM D 
および E タイプほど高い音量レベルではうまく機能しません。 

SDM D 
最もよく使用されるシグマ デルタ モジュレーションのタイプです。SDM D は大音量に適しており、最近のコ
ンピューターでは、トラック数が増えてもほとんどの場合問題なく使用できます。SDM D は、Pyramix 
DSDIFF ファイル形式のデフォルトのモジュレーターです。 

SDM E （Trellis E） 
これは リアルタイム操作 （録音）で使用するためのものではありません。これは SDM タイプの中で最も透
過的であり、オフラインでモジュレーション （Rendering、Offline Mix Downなど）を必要とする作業を行う場
合は、このタイプを選択して使用できます。ただし、処理に長い時間がかかることに注意してください。 

MTFF 
 

MTFF （Merging Technologies File Format）は、包括的なファイル形式として Mering 社のチームによっ
て開発されました。MTFF は、あらゆるサンプル レートと解像度の PCM または DSD のコンテナーとして
設計されています。メタデータを含めることもできます。 

DSD 制作で使用する場合、DSD128 または 256 を録音するときに使用するデフォルトのファイル形式に
なります。 独自の形式であるため、最終納品を目的としたものではありません。 

DSF 
 

DSF （dsd ストリーム ファイル）は、コンシューマー向けの DSD メディア フォーマットの不足に対処するた
めに 2008 年頃に導入された Sony フォーマットです。記録したファイルをソフトウェア DSD プレーヤーに
配信したい場合に適したフォーマットです。 

DSF の LSB と MSB の設定 
これらはデータ ストリームのビット順序を決定します。Intel ファミリーの CPU （Mac および PC）で使用さ
れるビット順序である LSB （リトルエンディアン）をお勧めします。ただし、何らかの理由で MSB （ビッグエ
ンディアン）を使用するプレーヤー用にファイルを作成する場合は、ここで情報に基づいた決定を下して、推
奨 （LSB）から MSB に変更することができます。どちらの場合も、音質には影響しません。 

WSD 
 

Sony の DSF に似ていますが、Korg によって開発および導入されました。ただし、DSD64 および 
DSD128 レートでのみ機能します。また、id3 タグは使用せず、代わりに基本的なトラック情報用のシンプ
ルな ASCII （英語テキスト）入力フィールドを提供します。WSD は MSB （ビッグエンディアン）ビット順序の
みを使用します。 
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ファイルの種類の概要と選択する場合： 

DSDIFF： ミキシング （レンダリング）をまったく行わずに SACD を直接作成する必要があ
る場合に使用します。SACD リリース用に古いアナログ マスターをキャプチャ
する場合、最良かつ「最もクリーンな」選択肢です。 

MTFF： 一般的な DSD 制作で、任意の DSD レート （64/128/256）で使用します。録音
したコンテンツをポスト プロダクションする予定がある場合、またはマスタリング 
プロセス中にミキシング モードを使用する場合は、これが使用するのに適した
デフォルトのファイル形式です。 

DSF/WSD： DSF/WSD 関連する種類のプレーヤーを持っている人やアーカイブ目的の人
が録音コンテンツを直接 （他のプロセスなしで）使用する場合は、これらを使用
します。これらのファイル形式は、録音形式としてよりも、最終的な配信ファイル 
（編集後など）としてはるかに便利な選択肢です。 

 

DSD プロジェクトにトラックを追加する 

プロジェクトの構築に関するセクションで述べたように、これは現時点ではアクティブなプロジェクト内では実
行できません。トラック数で開始すると、プロジェクト自体の存続期間中、これに縛られます。したがって、希
望する新しいトラック数で新しいプロジェクトを開始する必要があります。 

 
DXD プロジェクトでは、少し簡単です 

DXD プロジェクトは通常の PCM プロジェクトのように動作するため、トラックの追加に関してはるかに柔軟
になります。Track メニューの “Add Audio Track” 機能を使用して、トラックとストリップを追加するだけで
す。 

タイムライン の単位 
これは少し奇妙に思えるかもしれませんが、非常に重要なポイントです。DSD で作業する場合、DSDフ
レーム は CD フレームに基づいています。そのため、これらのフレーム エッジの外側で操作を行うと、奇妙
なアーティファクト （クリック音）が発生する可能性がでてきます。再生を開始し、録音を開始および停止し、
これらのフレーム エッジで編集する必要があります。したがって、次の設定を行ってください。: 

●​ Edit > Snap で Snap to Scale に設定する 
●​ Edit > Snap で Snap Cuesor に設定する 
●​ Edit > Snap で Snap Slection Head に設定する 
●​ VIew > Timecode Resolution で CD Frames に設定する 
 

NUDGE の設定 
NUDGE 機能を設定して、常に Frame の境界にいることが維持されるようにしてください。 

●​ All Settings > Editing を開きます 
●​ Nudge Preset 1 を 1 CD Frame に設定します 
●​ Nudge Preset 2 を 10 CD Frames 
●​ Nudge Preset 3 を 75 CD Frames（1 second）に設定します 
●​ Nudge Preset 4 を 750 CD Frames（10 Seconds）に設定します 

これにより、作業のすべてが Frame に準拠し、作業中に不要なノイズが回避されます。 
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DXDプロジェクトでDSDを録音する 

このハイブリッド ワークフローでは、すべてが正しく録音され、希望どおりに再生されるように、いくつかの追
加設定を行う必要があります。 

 
RECORD SETTINGS 
前のセクションの情報を使用してください。同じ考慮事項と選択が適用されます。 

 
SAMPLE RATE CONVERSION (SRC) SETTINGS 
この仕組みは、Pyramix が録音中の DSD 情報のリアルタイム SRC を実行し、ミキサーを介して出力に
再生するというものです。そのため、タイムライン SRC をオンにしておくことが不可欠です。 

信号フロー： 
Inputs -> A/D -> DSD Stream to Pyramix -> Recording as DSD on drive-> SRC to DXD -> Into 
Mixer -> Output Bus 

 SRC を正しく設定する: 

●​ All Settings > Playback/Record を開きます 
●​ Real-time Sampling Rate Conversion で DSD & Mastering HEPTA SRC を選択します 
●​ Pyramix アプリケーションを再起動します （これでアプリケーションに設定されるため、毎回設定する必

要はありません） 

これらすべてが設定されると、DXD プロジェクトで DSD 録音を操作できるようになります。 
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EDITING DSD 
純粋な DXD での制作では制約はありません。ただし、DSD では、フォーマットを最大限に活用するため
に、作業を開始する前にいくつかの点を知っておく必要があります。DSD ファイルに加えられた変更でゲイ
ン変更 （フェード、クリップ ゲインなど）を伴うものはすべて、常にそのクリップ （バックグラウンド）が DXD 
に変換され、出力時に再変調されます。編集を行う必要がない場合は、純粋な DSD のままになるセクショ
ンで再変調を過度に使用しないように、編集を行わない方がよいことに注意してください。 

 
DSD で CUTS, SPLICES, GAIN CHANGES,  FADES を行う 

DSD プロジェクトでは、各 CD フレームを正しく維持して Cut を行うことが不可欠です。フレーム間で Cut 
や Splice を行うと、その時点でクリック音やポップ音が発生しやすくなります。 

常に CD フレーム境界でカットしていることを確認する方法： 

●​ Snap が適切に設定されていることを確認します （これについては、DSD プロジェクトの開始 の章を参
照してください） 

●​ 常にカーソルが CD フレームにスナップして作業していることを確認します 
○​ 次の場合には、Snap 機能はカーソルに適用されません 

■​ Stop すると、CD フレームの外で停止することがあります 
■​ Tab を使用すると CD フレーム境界にない編集ポイントに移動することがあります 

●​ 注意：停止したら、そのポイントで最も近い CD フレームにスナップするために、常にカーソルがある
ルーラー バーをクリックします。 

●​ Cut を行うときは常にタイムライン カーソルを使用します （cutting tool modifier キーは使用しないでく
ださい） 

●​ メディアがスリップしないように最善を尽くしてください。Nudge コントロール と Nudge Preset を使用し
てください 

●​ メディアを手動でスリップさせる場合は、必ずスナップ設定が適用されていることを確認してください 
●​ メディアの一部を手動でスリップしたら、もう一方の端 （末尾）も境界で終了していることを確認してくだ

さい 
●​ フェード/クロスフェードを作成するときは、手動でドラッグするのではなく、次の操作を行なってください 

●​ クリップ内でフェードが到達する場所にカーソルを置きます 
●​ クリップを選択します 
●​ “[“ と “]” を使用して、選択の開始または終了をカーソルの位置に設定します 
●​ 右クリックして、選択した領域にフェードを適用します 

■​ Fade In > Fade In New 
■​ Fade Out > Fade Out New 
■​ X Fade > X Fade New 

CLIP GAIN 
タイムライン上の DSD メディアにクリップ ゲインの変更を適用することもできます。ただし、タイムラインで
行われた他のすべてのレベル変更と同様に、これはタイムライン上で DXD として再生され、フェードなどと
同様に再調整されることに注意してください。 

 

タイムライン上のメディア間のメディアのスリップと調整 
クリック音やポップ音が発生しないように、各クリップの端を CD フレーム境界に合わせる必要がある一方
で、つなぎ合わされるメディアを合わせるためにクリップ自体の中でメディアをスリップしたり移動したりして
もまったく問題がありません。タイムライン上でメディアをスリップする （SHIFT+CTRL キーを押しながらメ
ディアを移動する）と、問題なく機能します。 

注意すべき点:： 
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➔​ Fade Safe と Force Safeフェード セーフ を有効にして、フェード エディターを使用してメディアをスリッ
プさせた場合、タイムラインのさらに下のフレーム境界に問題が生じる可能性があります。タイムライン
のさらに下の編集もスリップされるため、フレーム境界から外れる可能性があります。 

◆​ これらが両方とも無効になっていることを確認することをお勧めします。 
◆​ スリップを使用する代わりに、CD フレームの精度を確保するために、次の方法を試してくださ

い: 
●​ 位置合わせするエリアの周囲に Mark In と Mark Out を設定します 
●​ タイムラインでエリアを選択し、ENTER キーを押してマークをインします 
●​ 2 秒のプリロールを入れるだけで十分です 
●​ トランスポートで Loop Playback をオンに設定 

●​ タイムラインで別のクリップに位置合わせするクリップを選択します 
●​ Clips>Select>Add All Following Clips to Selection を使用します 
●​ 次に、Nudge Clip を使用して選択範囲全体を移動します 

 
 

 

DSD ファイルへのエフェクトのレンダリング 

Pyramix の Render 機能を使用して、DSD タイム
ラインのファイルにエフェクトを加えることができま
すが、DSD64 のみです。 

このプロセスでは DXD への変換が必要であること
に注意してください。これは必ずしも悪いことではあ
りませんが、DSD 純粋主義者にとっては受け入れ
られない可能性があるため、議論する価値があり
ます。 

DSD プロジェクトでは、形式は DSDIFF である必
要があります。つまり、最終的には 2 つの変換を
行うことになります。1 つはファイルを処理するため
に DXD に変換し、もう 1 つは DSD64 に戻す変
換です。 

DXD プロジェクトでは、形式はむしろ MTFF である必要があります。最終的には 2 つの変換を行うことに
なります。1 つはファイルを処理するために DXD に変換し、もう 1 つはミキサー出力で DSD64 に変換す
ることです。 

DXD プロジェクトで DSDIFF を選択した場合は、3 つの変換を行うことになります。 1 つは DXD にファイ
ルを処理するために、もう 1 つはタイムライン上のファイル用に DSD64 に、もう 1 つはミキサー出力に、こ
れは避けるべきです。 

レンダリングに使用される PCM サンプル レートに関する注意 
➔​ DSD128 で作業する場合、処理の有効な PCM サンプル レートは DXD x2 （705.6 kHz）になります 
➔​ DSD256 で作業する場合、有効な PCM レートは 1.4112 MHz になります 

 
DSD RENDERER を使用したレンダリング 
このツールは、タイムライン上の他の部分から新しい DSD ファイルを生成するために特別に作成されまし
た。新しいファイルの作成は、最初に DXD にアクセスする必要がなく、タイムライン上の選択した領域の正
確な複製が維持されます。このツールは、Project > DSD Render にあります。ただし、これは桁から桁へ
のコピーを目的としているため、DSD バリアント間の変換も行われないことに注意してください。タイムライ
ンに DSD128 ファイルがある場合は、新しい DSD128 ファイルのみがレンダリングされます。他の DSD 
ファイル バリアントに変換する場合は、Album Publishing 機能を使用してさまざまな DSD マスターを作
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成するセクションを参照してください。DSD Render ツールは、clip gain, fades と phase invert. 
Envelopes が行えます。Envelopes は処理されません。 
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MIXING DSD 
 
DSD を DXD でミックスする 

DSD 録音をPC内でミックスする場合は、プロジェクトを特別なモードで開く必要があります。DSD プロジェ
クトを開いたり閉じたりすると、プロジェクトを開くたびに、プロジェクトを DXD Mixing Project に変換するか
どうかを尋ねるポップアップが表示されるはずです （Pyramix Settings > Application > General で 
“Ask DXD/DSD Conversion” オプションがアクティブになっている場合）。これは、DSD 素材をミックスす
るときにまさに必要なことです。 

これにより、基本的に、DSD を記録するように設定された DXD プロジェクトと同じように機能するプロジェ
クトが作成されます。DSD 素材をミックスすることがわかっている場合は、DSD を記録する DXD プロジェ
クトのセットアップ を使用することを検討してください。 

 

DSD プロジェクトを mixing mode で開くと、標準の PCM プロジェクトにいるかのようにミキシングできるよ
うになります。 

 

録音に使用した既存の DXD プロジェクトで DSD をミキシング 
DSD を DXD プロジェクトに録音して作業を開始した場合は、すでに上記の DSD ミキシング モード設定に
なっているので、すぐに始めましょう。 

このモードで注意すべき点: 

●​ All Settings > Application > Playback/Record で Real time SRC を有効にし、DSD & 
Mastering Hepta SRC に設定する必要があります。 

●​ Pyramix DSD を使用するときは、Pyramix ミキサーの 'Dither' 機能を常に Off にしておいてくださ
い。Redbook CD イメージ ファイルへの変換に必要な dithering/noise-shaping は、Generate CD 
Image / SACD Edited Master ウィンドウで行います。 
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MASTERING DSD 
録音が終了し、編集して、素材をミックスしてマスタリングする最終バージョンができたら、最終的に何を作り
たいか、どのように作成したいかに応じて、さらに考慮すべき点がいくつかあります。 

DSD RENDERING USING THE DSD RENDER 

これは、録音の DSD マスターを生成する最もシンプルで透過な方法です。タイムラインの内容をビット単位
でコピーし（ミキサーを通さずに）、そこから DSDIFF ファイルを作成します。このプロセスでは DSD レート
は変更されず、常に DSDIFF ファイルが作成されます。 

 

このプロセスで注目すべき点： 
➔​ タイムライン上のすべての純粋な DSD は、信号への変更が一切再変調されることなく、ビット単位でコ

ピーされます 
➔​ タイムラインで行われたすべてのフェード、クロスフェード、およびその他のゲイン変更は、DXD でレン

ダリングされ、タイムライン上の DSD ファイルのレートで DSD に再変調されます。 
➔​ タイムラインに何があるかに関係なく、DSDIFF は常にレンダラーの出力になります 

DSD CONVERTING 

異なる種類の DSD ファイルが必要な場合は、既存の DSD ファイルから別の種類の DSD ファイルを作成
できる追加のソフトウェアがあります。DSDCon-verter Tool.を使用すると、DSD256 ファイルなどから 
DSD64 ファイルを作成できます。 
このツールは、Start Menu > All Programs > Merging Technologies > Pyramix > DSD Converter に
あります。 

 

これにより、DSD形式を変更するだけでなく、WSDからDSFなどに変更することも可能になり、形式に関係
なくファイルを提供することが簡単になります。 

 

ファイルタイプの選択に関する注意 
変換するファイルの種類を決定する際に、一部のファイルの種類には、遵守する必要のある制限事項があ
ります。 

DSF： 1から 6チャンネルをサポート 

WSD： DSD128 までをサポート 
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MTFF： マスターを作成するためのチャンネル タイピング メタデータを備えた最大 6 つのチャン
ネルをサポート（納品用のファイナルではありません） 
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SACD MASTERING 
Super Audio-CD には、DSD 情報のみを含む Single Layer と、DSD と Redbook CD オーディオの両
方を含む Hybrid の 2 つの形式があります。後者は基本的に、Redbook CD を  Single Layer SACD に
貼り付けたものです。各レイヤーに異なる波長のレーザー光を使用することで、両方のレイヤーを物理ディ
スクの片面からのみ読み取ることができます。SACD レイヤーはさらに 2 つの Area に分割されます。1 つ
は 2 チャンネル DSD 用、もう 1 つは multi-channel DSD 用です。 

multi-channel オーディオの場合、最大チャンネル数は 6.0 です（すべてのチャンネルがフル周波数応答で
す）。その他の一般的なマルチチャンネル チャンネル タイプには、5.0、5.1、4.0、3.0 があり、2.1 や 2.0 な
どの他の可能性もあります（必要に応じて、multi-channel エリアに別のステレオ プログラムを配置すること
もできます）。 

multi-channel エリア用のファイルは、2、5、または 6 チャンネルのコンテナーに収める必要があります。 
'3.0' マルチチャンネル ファイル （L、C、R）を作成し、SACD レンダリング メソッドを使用する場合は、通
常、使用されないサラウンド チャンネルのペアが配置されるタイムラインに、非常に短い「ダミー」ファイルを
配置する必要があります。Pyramix DXD mixing mode では、ミキシング バスによって対応する数のチャ
ンネルが作成されるため、これを行う必要はありません。 

SACD マスタリング プロセスには、3 つの異なるステップがあります。 

1)​ トラック マーカーとメタデータが埋め込まれた、必要な領域ごとに連続した DSDIFF ファイルを作成し
ます（いわゆる  Edit Master ファイル）。 

2)​ Direct Stream Transfer（DST）ロスレス データ圧縮アルゴリズムを使用して Edit Master ファイルの
サイズを縮小し、ディスクの再生時間を効果的に増加させます。ステレオ のみの SACD では DST 圧
縮を適用する必要はありませんが、レプリケーターへのファイルの転送が確実に高速化されます。  

3)​ Authoring：製造前の最終段階。この段階では、DSDIFF Edit Master （または DST 圧縮バージョン）
が SACD Text とともに 1 つのファイルに多重化され、いくつかの小さな複製制御ファイルとともに、
SACD イメージ ファイルと呼ばれるものになります。このイメージ ファイルは、Sony の Cutting 
Master Converter アプリケーションを使用して、Unified Cutting Master Format ファイルに変換
されます。このアプリケーションからの出力ファイルを 電子的に送信するか、DVD-R に書き込んで、物
理ディスクとして複製業者に送ります。 

4)​ Manufacturing は このガイドの範囲外のトピックです。 

 
SACD ALBUM TEXT AND TRACK MARKERS 

SACD Maker を配置し、すべてのテキスト情報を手動で入力するか、Pyramix と互換性のあるファイルを
インポートします。これらの SACD テキスト ファイルには、すべてのトラック タイトル、アーティスト、および 
SACD をプレーヤーに挿入したときに表示されるその他のすべての情報に関するテキスト情報が含まれて
います。 
Hybrid SACD （DSD および Redbook CD オーディオ）を作成する必要がある場合は、最初に CD マー
カーを作成し、そこから SACD Text と Maker を作成する方が 遥かに優れています。 
SACD Text は、CD では事実上存在しない多言語サポートに関して CD Text よりもはるかに豊富です。2 
つのレイヤー間でテキストを一致させる必要がある場合、これは問題になる可能性があります。 
CD/SACD タブ のディスク アイコンを右クリックし、Copy Disc Info を選択して、データを別のディスクに
貼り付けることもできますが、一部のフィールドは SACD と CD で一致していないため、不足しているフィー
ルドを手動で入力する必要があります。 

これらのファイルは 2 つの形式で存在し、どちらも Pyramix でサポートされています： 
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●​ PHILIPS の SUPERAUTHOR または SUPERAUTHOR TOC エディター ソフトウェア （.LBM  
フォーマット） 

●​ SONY の SACD テキスト エディター ソフトウェア （.MTS フォーマット） 

SACD SPECIFIC CONTROLS IN THE CD/SACD TAB 

 
マルチチャンネルとステレオ領域 

マルチチャンネル DSD 編集とステレオ DSD 編集
をタイムライン上で並べて作成すると、一方のトラッ
クの Start, Stop, Index マーカーを設定し、もう一
方のトラックにコピーすることができます。これによ
り、Stereo バージョンが Multi-channel バージョン
とまったく同じように動作する SACD を提供するこ
とができます。領域を右クリックし、Copy 
Stereo/Multichannel area to 
Stereo/Multichannel area を行ってください。 
 

 
SACD エリア設定 

stereo と multichannel レイヤーの両方で、Render Mode で タイムラインをどのようにレンダリングするか
を知らせるために Area Type を設定する必要があります。この設定は Tree info タブにあります。 

1 つを除いて、エリア タイプはすべて完全に意味をなすはずです。Stereo + Extra Data は現在実装され
ていないため、役に立ちません。 

SACD タブのその他のすべての設定とエントリー領域には プロダクション、レーベルアーティストの情報が
含まれています。 

 

SACD TEXT 

SACDテキストには、SACDを制作した国や、実際
に追加したいテキスト情報の種類に応じて、いくつ
かの設定があります。 

SACD Area を作成したら、まず最初に 各エリアの
テキストタイプ情報を設定します。 
 
1.​ 左側の領域で SACD ディスクを選択します 
2.​ ジャンルを割り当てる場合は、Genre テーブル

を一般ジャンル （または必要に応じて日本語
ジャンル）に設定してから、下のジャンルを選択
します。 
SACD ディスクにジャンルを設定しない場合
は、Genre Table を TABLE NOT USED に
設定していることを確認してください。Not 
Used や Not De-fined は機能しません。 

3.​ ディスク領域の 1 つを選択します 
4.​ 最初の SACD 領域の Tree Indo エリアに移動します。 
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5.​ 下のセクションまでスクロールすると、Area Text が表示されます。 
6.​ 言語の文字セットを設定します 

a.​ ASCII 文字セットは Enflish にのみ適しています。 
b.​ ISO 8859-1 は、ラテン語、スカンジナビア語、東ヨーロッパの言語をカバーします。 
c.​ 日本語の場合は Music Shift-JIS 
d.​ 韓国語の場合は KSC-5601 
e.​ 中国語の場合は GB2312 

7.​ 文字セットの下のフィールドで使用する言語を設定します 
 
ステレオとマルチチャンネルエリアの両方で、文字セットが一致している必要があります。異なる場合、
Cutting Master 作成のプロセスで失敗します。 
 

CREATING THE DSD EDITED MASTER 

DSD Edit Master は、オーディオ コンテンツを SACD オーサリング ファシリティに配信するために使用さ
れる特定の種類の DSDIFF ファイルです。すべてのオーディオは、2、5、または 6 チャンネルの 1 つのマ
ルチチャンネル ファイルに保存されます。ファイル ヘッダーには、「Scarlet Book」準拠の SACD ディスク 
イメージを作成するために使用されるデータが含まれています。これには次のものが含まれます。 

●​ スピーカー構成 （ステレオ、サラウンド 5.0 またはサラウンド 5.1） 
●​ Marker（Start, Stop, Index） 
●​ Edit Master ID 
●​ アーティスト名 
●​ ディスク タイトル 

SACD の Preliminary Mastering process の目標は、次の 2 つの方法のいずれかで Edit Master を作
成することです。 

 

USING RENDER MODE 

これは、タイムライン上に存在するメディアをレンダリングするだけなので（DSD Rendering Toolと同様
に）、SACD ディスク情報を出力に追加するという追加作業を行うだけなので、SACD を生成するための最
も純粋な方法です。最終マスターのトラック順序を反映するために、メディアが正しいトラック順序で配置さ
れている必要があります。Render Mode での SACD Edit Master の作成では、使用されるメディアの数
が自動的に検出され、それに応じてメタデータが作成されます。 
ここで、前述の ダミー ファイルが SACD Render Mode を「だまして」、Multichannel ファイルに 5 または 
6 チャンネルがあると思わせるのに便利です。 
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SACD TRACK LAYOUTS FOR THE TIMELINE： 
5.1 SURROUND 5.0 SURROUND 2.0 STEREO 

1.​ Left 1.​Left 1.​ Left 

2.​ Right 2. Right 2. Right 

3.​ Centre 3. Centre   

4.​ Lfe 4. Left Surround  

5.​ Left Surround 5. Righ Surround  

6.​ Righ Surround   

 
NOTE 
他の異なる スピーカー構成 （4.0 “Quad” ミックスや LCR 3.0 ミックスなど）を作成したい場合は、サウンド
が入らないトラックに短い無音の DSDIFF ファイルを配置する必要があります。これを行うには、Render 
機能を使用します。 

1.​ 空のトラックで、タイムラインの小さな部分を選択します。 
2.​ Project > Render を選択します。 
3.​ Render ウィンドウで、None を選択します。 
4.​ File Type に DSDIFF を選択します。 
5.​ 選択範囲を新しいメディアとしてレンダリングします。 
6.​ 空のトラックの、最初の SACD Maker の位置に 無音の DSDIFF ファイルを配置します。 

これにより、PCM の世界 （DXD）で既にデジタル無音になっている状態から DSD への変調が行われるた
め、真のデジタル無音が作成されます。レンダリング プロセスでは、アクティブ チャンネルのオーディオとと
もに残りの無音が作成されます。 
 
RENDER MODE でのワークフローの提案 

1)​ サラウンド  エリア用の Track Group とステレオ エリア用の Track Group を作成します 
2)​ 両方のセクションを互いに一列に並べて編集し、一致するセットにします （両方とも互いに位相が揃っ

ています） 
3)​ CD/SACD タブでサラウンド エリアが選択されているタイムラインに SACD マーカーを追加します 

a)​ エリア タイプが正しく設定されていることを確認します。 
4)​ すべてのトラック情報を追加します 
5)​ 完了したらマーカーをコピーし、ステレオ エリアに貼り付けます 

a)​ ツリー情報がステレオ エリア タイプに設定されていることを確認します。 
6)​ ドキュメント ライブラリを使用して、各エリアを個別のドキュメント ライブラリ編集として保存します 
7)​ タイムラインからステレオ編集を削除し、サラウンド エリアをレンダリングします 
8)​ 完了したら、タイムラインからサラウンド エリアを削除し、ドキュメント ライブラリに移動してステレオ エ

リアをその場所に配置します 
a)​ タイムラインでトラック 1 を選択します 
b)​ ステレオ エリアを右クリックします 
c)​ 選択したトラックの元のタイムコードに配置を選択します 

9)​ ステレオ領域をレンダリングします。 
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GENERATE THE EDITED MASTER IN RENDER MODE: 

Generate Master メニューの Master Settings で、Tyype を DSD Edit Master（DSDIFF）、Sample 
Rate を DSD64（SACD）に設定し、DSD Rendering mode を選択します。また、選択した領域の場所と
名前を設定します。 
Render mode では、ゲインの変更、フェード、位相反転が適用されますが、エンベロープの変更は適用さ
れないことに注意してください。 
Pyramix ver12以降では、”Process DSD at original Sample rate（元のサンプルレートでDSDを処理）” 
により、元のDSD素材のサンプルレート（DSD64の場合は64 Fs、DSD128の場合は128 Fs、DSD256の
場合は256 Fs）で DSD Rendering 処理（ゲインとクロスフェード）を実行できます。 
Stereo Area と Multichannel Area の両方を用意する場合は、DSTエンコードされたファイルが必要にな
るため、post processomg セクションで DST Encoding を有効にしてください。 
DST エンコードは後から実行することもできます。SACD Mastering Appendix を参照してください。 

 
 

MIXING MODE を使う 

Mixing Mode は、DXD プロジェクトで作業している場合、またはあらゆる種類の PCMを使用している場合
に使用します（44.1 kHz 素材から SACD を作成することを推奨しているわけではありません）。 

このモードでは、すべての素材が DXD に変換され （リアルタイムで）、タイムラインからミキサーに信号が
送られ、出力段階で DSD に再変調されます。これは、プロジェクトを開始したときに選択した内容 （
working with DSD in a DXD projectを参照）か、プロジェクトを開く時に “Open in DXD Mixing Mode” 
を選択したことによります。いずれにしても、最終的な DSD Edit Master ファイルを作成するには、Mixing 
Mode を使用します。 

これには、作成する DSD Edit Master のチャンネル タイプ （5.1, 5.0, Stereo）を反映するバスが必要で
す。その後、マスターを作成するときに、この出力をマスターのソースとして選択します。 

Generate Master のメニューで、必要な領域を選択し、対応する出力バスにチェックマークを付けます。マ
ルチチャンネル領域の場合、チャンネル マッピングが SACD チャンネル マッピングであることを確認してく
ださい（上記の SACD トラック レイアウトを参照）。SACD トラック レイアウトと一致する 5.0 または 5.1 
SMPTE バスを使用してください。Edit Master の各領域は個別に作成する必要があります。 
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次に、Master Settings で、Type を DSD Edited Master（DSDIFF）に設定し、Sample Rate を DSD64 
（SACD）に設定します。 

SACD の作成に対応しているのは DSD64 のみで、DSD128 と DSD256 は対応していません。Album 
Publishing プロセスでは、より高い DSD サンプリング レートから DSD64 Edit Masterを生成することもで
きます。 

選択した Area の場所と名前も設定します。 

Stereo Area と Multichannel Area の両方を作成する場合は、DST エンコードされたファイルが必要にな
るため、Post Processing セクションで DST Encoding を有効にしてください。 

DST Encoding は後で実行することもできます。SACD Mastering Appendixを参照してください。 

 

DSD Edit Master が作成されると、複製工場に送るために必要なものがほぼすべて揃い、工場では 
SACD イメージを構築して、それを使用して最終的な SACD を作成できます。 

ただし、これはもちろん費用がかかるサービスです。Pyramix では、PSO-SAA オプション （SACD ディス
ク オーサリング オプション）を加えると、最終的な UCM （Universal Cutting Master）を作成して工場に送
り、複製プロセスで使用できるようにします。 
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USING THE SACD CUTTING MASTER 

このツールは、Pyramix の Super Audio CD Authoring および Disc Builder オプションを購入したユー
ザーが利用できます。以下の内容に興味がある場合は、お近くの Merging Technologies の代理店に連
絡して、ライセンスでオプションを有効にしてください。SACD Cutting Master は、SACD ディスクを作成す
る最後のステップで使用されます。 

 

実行する手順 
➔​ Disk Image 名を入力します。 

Note：文字は制限されており、無効な文字は自動的に変換されます。 
➔​ 中間イメージ フォルダーと最終イメージ フォルダーを指定します。 

中間フォルダーとイメージ フォルダーを選択するときは、書き込み先のボリュームに常に少なくとも 20 
GB の空き容量があることを確認してください。これは、オーサリング プロセス中に多数の中間ファイル
が作成されるためです。 

➔​ Input Audio Files セクションに、Stereo および/または Multichannel  Edit Master ファイルを指定し
ます。ファイルがまだ DST エンコードされておらず、DST が必要な場合は、エンコードを実行できま
す。 

➔​ Generate ボタンをクリックします。 
Save as ウィンドウで、.lbm ファイルの名前とパスを入力できます。 

 

THE SACD DISK BUILDER 

この時点で、次のものができているはずです: 
1.​ Multi-Channel DSD Edit Master 

a.​ DST エンコード済み 
2.​ Stereo DSD Edit Master（必要な場合） 

a.​ DST エンコード済み 
3.​ SACD テキストからエクスポートされた .lbm  
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SACD Builder は非常に簡単なツールです。マスタリング プロセス中に生成したコンテンツを適切な領域に
入力し、処理を実行するだけです。 

NOTE 
中間フォルダーとイメージ フォルダーを選択するときは、書き込み先のボリュームに常に少なくとも 20 GB 
の空き容量があることを確認してください。これは、オーサリング プロセス中に多数の中間ファイルが作成
されるためです。 
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AFTER THE CUTTING MASTER – MAKING THE UCMF FILE 

Unified Cutting Master フォーマットは、ウィザードによって作成された Sony Cutting マスターを変更した
イメージ です。 
このツールは Sony によって開発されたため、Merging ではこのツールを変更したり機能を追加したりする
ことはできません。 
Merging社の Web サイトから Sony Cutting Master コンバーターをダウンロードし、任意の場所に解凍し
ます：http://www.merging.com/CMConv_ver1120 
 
実行する手順： 
➔​ CuttingMasterConverter.exe を起動します。

デフォルトでは常にテープ デバイスを検索しま
す。OKをクリックして警告メッセージを閉じます。 

➔​ Sony CM を Medium1 に選択します。 
➔​ DiscBuilder によって生成されたイメージファイ

ル（.DAT ファイル）を含むフォルダーを参照しま
す。 

➔​ SA-CD UCMF フォーマットを Medium2 に選
択します。 

➔​ Convert & Compare に設定します。 
➔​ Execute をクリックします。 
 
警告やエラーがある場合は、ログを参照できます。 
残念ながら、ログの表示機能は最近のコンピュー
ターでは動作しませんが、ログ ファイルを表示するこ
とはできます。 
CMConv ver1120 フォルダーを参照して、cmconv_log.xml を開きます。 
処理されたすべての UCMF 変換のログが取得されます。最新のものを参照してください。 
“warn” と “error” のエントリのみに注意してください。 

 
MAKING THE REDBOOK CD LAYER FOR HYBRID SACD DISCS 

ハイブリッド SACD を作成する場合は、Redbook 標準の CD-R または DDP も別途用意する必要があり
ます。これを DSD Edit Master（必要に応じてマルチチャンネルとステレオの両方）と一緒に提供して、
Cutting Master を作成し、生産を開始できます。ハイブリッド SACD の Red Book オーディオを作成する
方法はいくつかあり、DSD マスターの作成方法に応じて選択する方法が異なります。CD マーカーとメタ
データはすでに作成されているものと想定しています （オプション #4 を除く）。 

1.​ DSD プロジェクトから Edit Master を作成するために “SACD-REDER” モードを使った場合。 
1.1.​ プロジェクトを DXD Mode で開きます （Pyramix Settings で ”Ask for DSD/DXD 

conversion” オプションをオンにします）。 
1.2.​ CD / SACD タブで、SACD 領域から PQ マーカーを選択し、右クリックのコンテキスト メ

ニューから “Copy Markers” を選択します。 PQ マーカーを CD Disc セクションに貼り付けま
す。 

1.3.​ Project メニューから “Generate CD/SACD” を選択し、Image Format オプションから 
“RedBook CD Image” を選択します。 

1.4.​ 適切な出力バス、ディザリング、および SRC アルゴリズムを選択します。 
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2.​ DXD mixdown を使用して Edit Master を作成した場合。 
2.1.​ “CD/SACD” タブで、SACD 領域から PQ マーカーを選択し、右クリックのコンテキスト メ

ニューから “Copy Markers” を選択します。PQ マーカーを CD ディスク セクションに貼り付
けます。 

2.2.​ Project メニューから “Generate CD/SACD” を選択し、Image Format オプションから 
“RedBook CD Image” を選択します。 

2.3.​ 適切な出力バス、ディザリング、および SRC アルゴリズムを選択します。 

3.​ PCM プロジェクトを使用して Edit Master を作成した場合。 
3.1.​ Project メニューから “Generate CD/SACD” を選択し、Image Format オプションから 

“RedBook CD Image” を選択します。 
3.2.​ 適切な出力バス、ディザリング、および SRC アルゴリズムを選択します。 

4.​ 4）Red Book オーディオは他の場所で作成した場合。 
4.1.​ Red Book オーディオの CD-R または DDP が Unified Cut-ting Master Format ファイル 

セットに含まれていることを確認するだけです。 

 
CHECKING YOUR WORK 

デュプリケート用に提供しようとしているものが実際に機能するかどうかを確認することは非常に重要なス
テップです。UCMF 形式のマスターを作成する前に、SACD Cutting Master を Pyramix にインポートし直
して、すべて（および音）が計画どおりに機能するか確認することができます。 

 
IMPORTING THE SACD CUTTING MASTER 
1.​ Project > Import… を開きます。 
2.​ リストから SACD Cutting Masterを選択し、新しいプロジェクトを作成するか、既存のプロジェクトと比

較する場合は Append を選択します。 
3.​ Cutting Master ファイル （.DAT）を見つけてインポートします。 
4.​ ファイルがタイムラインに載ったら、出力にルーティングして試聴します。 

UCMF マスターは、UCMF ”.DAT” ファイルの名前を “Filename.DAT.ISO” に変更するとオーディオファイ
ル再生アプリケーションを使用して開くこともできます。その後、テキストと提供されているすべてのオーディ
オの両方を確認できます （DSD 対応 DAC をお持ちの場合）。動作することがわかっているアプリケーショ
ンは、JRiver Media Center（Windows）、AIMP（Windows）、USBAudioPlayer Pro（Android）、
Audirvana（Mac）です。 
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SACD MASTERING APPENDIX 

 

.LBM （または .MTS ファイル） 

これらは SACD 制作で使用するために生成される TOC ファイルのタイプです。このファイルは、プロセス
の一部として Cutting Master ウィザードによって自動的に生成されますが、手動でエクスポート （またはイ
ンポート）することもできます。 

NOTE： 
SACD Authoring オプションがない場合は、エクスポートされた TOC には、各インデックスの TC 
reference が含まれません。 

Generate SACD Cutting Master を使用していない場合でも、SACD テキスト情報の配信として使用する
ために .LBM または .MTS ファイルをエクスポートできます。 

.LBM または .MTS ファイルを手動でエクスポートする手順: 
➔​ CD/SACD タブを開きます 
➔​ SACD Text ドロップダウンで Export を選びます 
➔​ ファイル タイプ （.lbm または .mts）を選択し、ファイルの保存場所を選択します。 

 
 

 
ANNEX D3 検証 

Annex D3 Check により、SACD Scarlet ブックの 
Annex D3 仕様に準拠できるかどうかが保証されま
す。許容される最大レベルは 0dBSACD であること
が規定されています。 
 
 
 
 

 
ANNEX D4 FAILS の対処法 – DSD マスター に HFノイズが多すぎる場合。 

Annex D3 検証が失敗した場合、SACD Scarlet ブックで許容される量よりも HFノイズが多いことを意味し
ます。したがって、この HF ノイズを減らすために何らかの対策を講じる必要があります。 
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HFノイズを除去するには、プロジェクトを DXD Mixing Mode で開き、出力バスに EQx プラグインを追加し
てください。次に、LPF（ロー パス フィルター）を使用して 40～50 kHz 付近またはそれ以上の周波数を除
去し、非常に穏やかな量に設定します。高周波数で機能するほど、より顕著なカットになります。 

出力バスで結果として生じるノイズの量を確認するには、ミキサー メーターのフィルターを変更する必要が
あります。40-100kHz に設定した VS3 VU プラグインを追加するか、All Settings > Mixer > Level Meter 
で、DSD Peak Filter を 40-100kHz に切り替えて測定します。 

これを設定したら、DXD ストリームから DSD に再変調する “Mixing Mode” を使用してマスタリングを行っ
てください。ワークフロー全体で純粋な DSD が維持されないため、これは明らかに理想的ではありませ
ん。ただし、SACD が作成できないよりも、再変調する方がよいでしょう。 
 

 
DST ESTIMATION & ENCODING 

DST エンコードは、1 枚の光学ディスクに大量のメディアを格納できるようにするアルゴリズムです。これ
は、サウンドをまったく変えずに各 DSD Edit Master のサイズを縮小するエンコード プロセスです。 

 

最初のステップとして、DST estimator tool を使って、個々の DSD Edit Masterをエンコードした後にどれ
だけのスペースが残るか計算​​できます。数分で、最終的なエンコード サイズをかなり正確に表示できます。
これは、メディア マネージャーで右クリックすると見つかります。 

estimator tool と Encoder はどちらも Media Manager にあります。Media Manager ビューで DSD Edit 
Masterを選択し、右クリックしてコンテキスト メニューで両方にアクセスできます。ただし、SACD Cutting 
Master ウィザードはこれを自動的に行うため、このコンテキスト メニューは ファイナル ファイルのサイズを
推定するためにのみ使用し、Cutting Master ウィザードにエンコードさせることをお勧めします。 

エンコードに使用する “strategies” の選択 

DST エンコード時に選択できる “strategies” はいくつかありますが、それらはエンコーダーの動作方法と、
達成されるサイズの圧縮量に関係します。 

SAME FOR ALL CHANNELS (00 / 000000)（すべてのチャンネルで同じ） 
「すべてのチャンネルで同じ」は、チャンネル間の相関性が良好な素材 （同じ音楽で、一般的にほぼ同じ音）
に使用します。常に 00 を安全な選択肢として選択できます。 

DIFFERENT FOR EVERY CHANNEL (01 / 01234 / 012345)（すべてのチャンネルで異な
る） 
この strategies は、ステレオ（01）、5 チャンネル （01234）、または 6 チャンネル （012345）マスターのト
ラック間に相関性がほとんどまたはまったくない場合に使用します。 
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SAME FOR STEREO PAIRS (00122 / 001233)（ステレオ ペアで同じ） 
この strategies は、5 チャンネル （5.0）または 6 チャンネル（5.1）DSD Edit Masterで使用します。これ
は、左と右（00)、センターのみ（1）、Lfe のみ（2）、左サラウンドと右サラウンド（5 チャンネルの場合は 22、
6 チャンネルの場合は 33）の間の相関関係を前提としています。 

DST estimator を使用し、DSD Edit Master をそれぞれで試すと、実際のエンコード時にどれが最も成功
するかがわかります。 
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DSD DIGITAL ALBUM PUBLISHING 
現在、SACD や物理メディアは衰退傾向にあります。大きなファイルを高速にダウンロードできるようになっ
たことで、ほぼすべてのジャンルで ハイレゾリューションの音楽のダウンロードに対する要望が急増してい
ます。DSD/DXD コミュニティもこの流れに乗っています。 
Pyramix はさまざまな形式の DSD デジタル ダウンロード ファイルを作成できます。 

HOW THE PROCESS WORKS 
すべての生成プロセスは、常に上記のセクションで選択した内容から始まります。DSD で ダウンロード ファ
イルのみを生成する場合でも、CD/SACD タブで SACD を作成し、すべての情報を入力する必要がありま
す。これは album publishing tool がすべての情報を使用して、作成するデジタル ダウンロード ファイルの
メタデータを入力するためです。 

 
1.​ Project > Generate Master を選択します 
2.​ Master Settings で、DSD Digital Release（MTFF）、マスター ファイルのサンプリング レートとモー

ドを選択します。 
3.​ Album Publishing を有効にし、クリックして設定を開きます 
 

 
SETTING UP THE ALBUM PUBLISHING SETTINGS 
TO GET WHAT YOU WANT OUT 

このウィンドウでは、任意の数のファイルのセットを決定できます。
各セットは独自のフォルダに配置され、SACD TOC 内の豊富なメ
タデータを使用して名前を付けることができます。 

➔​ クリックしてファイル タイプを追加します 
➔​ 上部のドロップダウンからファイル タイプを選択します 
➔​ それぞれのサンプル レートとビット数を選択します 
➔​ ダウンコンバートする場合は Dither を選択します 
➔​ アルバム全体を 1 つのファイルにするか、曲ごとに別のファイ

ルに分割するかを選択します 
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ウィンドウの下部にあるセクションでメタデータ情報を編集することで、ファイル名の付け方を慎重に編集す
ることもできます。また、作成するファイルの種類ごとにファイルの場所もここで設定する必要があります。 

これが完了すると、generation process を開始できます。デジタル ダウンロード ストアに送信する準備が
整った多数のファイルが作成されます。 
 

A NOTE ABOUT FILE TYPE CHOICES：ファイル タイプの選択に関する注意 

DSD Converter のセクションでも述べたように、変換するファイル タイプを決定する際には、いくつかの制
限事項を遵守する必要があるため、特別な注意が必要です。 

DSF：1 ～ 6 チャンネルをサポートします。 

WSD：最大 DSD128 までをサポートします 

MTFF：マスターを作成するためのチャンネル タイプ メタデータを使用して最大 6 チャンネルをサポートしま
す。MTFF は独自の形式であるため、現時点では最終納品用ではありません。 

DSDIFF Edit Master：DSD64 を使用して SACD Cutting Masterを生成できます。圧縮設定により、プ
レーン DSD データまたは DST エンコード ファイルを作成できます（SACD Cutting Masterにステレオ領
域とマルチチャンネル領域の両方が存在する場合に必要）。 

これらの DSD 形式には、Sigma Delta モジュレーターが選択できます。 

Meco SDM（v12以降、出力フォーマットのSDMセクションで利用可能）は、DSDフォーマットから別の
フォーマット（DSD256からDSD128など）にパブリッシュする際に、高サンプルレート（64および128 Fs）の
中間マルチビットステージを可能にします。 

SDM D および Trellis E は、DSDフォーマットから別のフォーマットにパブリッシュする際に、高PCM変換（
DXD X1 / X2 / X4）を実行します。 
 

 
作業の確認 

Digital Album Publishing ワークフローでは、すべてのファイルがタイムライン上に簡単に配置できるため
簡単です。すべてのファイルを Media Manager に表示し、Pyramix タイムライン内でリスニング テストを
実行できます。Master MTFF、Edit Master、または Cutting Master ファイルは、Project > Import メ
ニューから使用できます。生成したファイルのネイティブ サンプル レートで再生するプロジェクトを使用して
ください。そうしないと、SRC も聞くことになります。 

前述のように、一部のオーディオ ファイル アプリケーションを使用して、Pyramix 外でファイルを確認するこ
ともできます。 
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DSD の標準 CD マスタリング 
CD はまだ売られているので、、SACDの情報を標準の Red-Book CD レイアウトに変換する可能性があ
ります。最初の手順は、CD/SACD タブ ウィンドウで CD ディスクを作成することです。 

 
CD テキスト情報を SACD 領域から 取得する 

CD マスターまたは DDP イメージの生成に使用するために、SACD から CD ウィンドウに情報をコピーす
る簡単な機能があります。 
 
CD/SACD タブの Disks > Create CD 
Disk from SACD Diskを選択すると、
このウィンドウが表示されます。 

情報を取得したら、通常の CD マスタリ
ング ワークフローに従って下さい。 

16 ビットの Red Book イメージには
dithering を適用する必要があることに
注意してください。 
 

 

 

終わりに 
これで、あらゆる目的の DSD プロジェクトを完了するために必要なことをほぼすべてカバーできました。も
ちろん、何かが足りないと感じたり、このワークフロー ガイドの使用がどのように役立ったか （または役に立
たなかったか）を知らせたい場合は、いつでも www.merging.com/contact までお気軽にご意見をお寄せく
ださい。 
 
Merging チーム 
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